
  نام خدابه
  

  مقدمه چاپ دوم
ف خدا جلد اول كتاب محاسبات ساختمان با استقبال خوب همكاران ارجمند مواجه شد به لط

   .رسيد به چاپ دوم كتاب ،بطوريكه يك سال پس از انتشار
روش . سازي انجام گرفته است در مدلPΔدر چاپ دوم تجديد نظري در مورد نحوه اعمال اثر 

 انطباق بيشتري داشت، در اين چاپ روشي 2800معرفي شده در چاپ اول با ويرايش دوم استاندارد 
 است، همچنين با توجه به اينكه 2800 ويرايش سوم استاندارد پيشنهاد شده است كه منطبق با روش

هاي  تهيه شده بود، با توضيح در مورد قسمتETABS 2000افزار  نرم45/8كتاب بر مبناي نسخه 
  .افزار پوشش داده شود نرم9تغيير يافته در چاپ دوم، سعي شده است نسخه 

 قرار گرفته است تا خوانندگان چاپ www.OmranKadeh.netموارد تجديد نظر شده در سايت 
  .اول نيز، قادر به استفاده از اين مطالب باشند

 " ضروري قبل از مطالعه كتابتوضيحات"شود قبل از مطالعه كتاب حتماً قسمت توصيه مي
  .مطالعه فرماييد 4در صفحه را 

 اول كتاب با صرف زماني در حدود بيست ماه شكل گرفت، مسلماً ارائه قابل قبول جلد دوم نيز جلد
 فرصت مناسبي كه براي ،متاسفانه به دليل محدوديت زماني و مشغله كاريطلبد كه زمان زيادي مي

از از نقاط مختلف ايران تماس زيادي كه همكاران محترم .  بدست نيامد،تكميل جلد دوم لازم بود
 پيگير جلد دوم كتاب بودند، مرا بر آن داشت تا به هر وبا بنده داشتند  Emailطريق تلفن و ارسال 

 در 1386طريق ممكن زماني را به تكميل جلد دوم اختصاص دهم و به اميد خدا اين مجموعه در سال 
  .اختيار همكاران محترم قرار خواهد گرفت

ي كه با مطالعه دقيق كتاب و ارائه نظرات و پيشنهادات  از همكاران محترممداندراينجا لازم مي
 بخصوص جناب آقاي مهندس صمد آقا زاده و ،اصلاحي و فني خود، افتخار آشنايي با آنها را يافتم

بخشي از اين نظرات و پيشنهادها در پيوست ششم . جناب آقاي مهندس علي سليماني نيا تشكر نمايم
گرامي نيز تقاضا دارم نظرات اصلاحي و فني خود را منعكس نمايند از ساير همكاران . كتاب آمده است

  .تر باشيماي كاملتر و كم نقصهاي بعدي قادر به ارائه مجموعهتا در چاپ
 اظهار لطف نموده و مشوق Emailدر انتها از تمام همكاران ارجمندي كه با تماس تلفني و ارسال 

  . نمايم مي تشكر و قدرداني،بنده در ادامه مسير بودند
  محمدرضا طباطبايي 
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  توضيحات ضروري قبل از مطالعه كتاب
  

  امكان معرفي ديافراگم ETABS 2000افزار  نرم9در نسخه  -1
   اين امر از طريق افزودن گزينهوت  نيمه صلب فراهم شده اس

  ๏ Semi Rigidدر قسمت ┘ Rigidity └مربوط به دستورات  
 Assign > Joint/Point > Rigid Diaphragm … ) و )195صفحه  

Assign>Shell/Area>Rigid Diaphragm… )استميسر) 207 صفحه .  
 9در نسخه  410و  406 مندرج در صفحات …Display >Set Output Table Mode دستور -2

  .شود اصلاح مي…Display>Show  Tablesبه صورت  ETABS 2000افزار نرم
 در چاپ دوم نسبت به چاپ اول، مقادير تغيير مكان جانبي PΔ با توجه به اصلاح تركيب بار -3

  :استخراج شده پروژه فولادي و بتني به شرح زير خواهد بود 
Cm9/14 = UY ،Cm0/9 = UX : و   يپروژه بتن   Cm 8/1 = UY ،Cm2/17 = UX :  پروژه فولادي  

انداز نما و غير نما جابجا انداز خرپشته اولاً وزن دست كتاب براي محاسبه وزن دست269در صفحه  -4
  : متر درنظر گرفته شده كه اشتباه است و محاسبه صحيح آن به شرح زير است1منظور شده، ثانياً ارتفاع آن 

  
فولادي KgWD 10343310807228080722524802572 =××+××+×+××= ///)//()//(
بتني kgWD 11045310807228080722525302572 =××+××+×+××= ///)//()//(  
كند با توجه به آنكه بارهاي محاسبه شده بيشتر از مقدار واقعي است و ايمني سازه را دچار اشكال نمي

و از طرف ديگر تاثير كمي در محاسبات سازه و نتايج نهايي خواهد داشت، از همان مقادير محاسبه 
  .ا نيازي به تغيير مدل نباشد استفاده شده ت269شده در صفحه 

 ضميمه كتاب به عهده دوست عزيزي بود كه به دليل ادامه تحصيل ايشان در CD زحمت تهيه -5
هاي  ضميمه آماده ارائه نيست، اما فايلCDخارج كشور از همكاري با ايشان محروم شديم و هنوز 

  .قابل دريافت است  www.OmranKadeh.netمحاسباتي پروژه بتني و فولادي از طريق سايت 
ها، احتمالا هاي زماني براي تكميل جلد دوم و سوم و پيشگيري از تاخير در ارئه آنا توجه به محدوديت ب-6

 .هايي از يك مجموعه ارائه خواهند شدصورت قسمتتدريج و بهمطالب مربوط به جلد دوم و سوم به
هاي آموزشي و سمينارهاي تخصصي  از دورهتوانند مي مطالبهمكاران محترم تا تكميل شدن مجموعه

هاي جزييات مربوط به دوره.  آموزشي عمرانكده استفاده نمايند–برگزار شده توسط موسسه علمي 
  .استآموزشي و سمينارهاي تخصصي در پيوست چهارم درج شده

اپ  قرار گرفته است تا خوانندگان چwww.OmranKadeh.net  موارد تجديد نظر شده در سايت-7
  .اول نيز، قادر به استفاده از اين مطالب باشند

  بار مرده سقف خرپشته انداز نمادست انداز غير نمادست

۴ 
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   در محاسبات سازهΔPلزوم اعمال اثرات  -7-1-2-1
 10 كمتر از شاخص پايداري طبقهكه  در صورتي ،2800 استاندارد 5و پيوست  6-2مطابق بند 

 الزامي به اعمال ،)ندنگرهاي خمشي اوليه باش ده درصد للنگرهاي خمشي ثانويه كمتر از(درصد باشد 
   . در محاسبات نيستΔPاثرات 
  حتي اگر شرط،هاي بتني مهاربندي نشده در مورد قابETABS افزاردر صورت استفاده از نرم :تذكر

  . منظور نمود را در محاسباتΔP اثرات  د باي،فوق برقرار باشد
  . تشريح شده است2800 استاندارد 5 پيوست 1 در بند،شاخص پايداري طبقه :تذكر

  
 ΔP  بارتركيب -7-1-2-2

سازي معرفي شده بود با ويرايش دوم  در مدلΔPروشي كه درچاپ اول براي منظور كردن اثر 
شود كه منطبق با روش ري داشت، در اين چاپ روشي پيشنهاد مي انطباق بيشت2800استاندارد 

  .  است2800ويرايش سوم استاندارد 
 كه در محاسبات نيروهاي داخلي  جانبي طبقاتهاي تغيير مكان،2800 استاندارد 6-2مطابق بند 

  . باشندuiΔهاي جانبي افزايش يافته طبقات، شوند بايد تغيير مكانكار برده ميبه
 بار هاي تركيب نبايد در ضريبR7/0شود ضريب  مشخص مي2800با توجه به اين بند استاندارد 

ΔPها را كه از  ضرب شود و تنها هنگام كنترل تغيير مكان جانبي نسبي بايد مقادير اين تغيير مكان
حوه كنترل تغيير مكان جانبي نسبي طبقات در ن.  ضرب نمودR7/0 در ،تحليل سازه بدست آمده است

  .هاي فولادي و بتني تشريح خواهد شدجلد دوم و در قسمت مربوط به طراحي اسكلت ساختمان
 را در محاسبات داراست و تنها بايد تركيب بار موثر در ΔP قابليت اعمال اثر ETABSافزار نرم

ΔPكه از اين پس تركيب بار -  راΔPبه آن معرفي نمود-شود ناميده مي  . 
 بارهاي ثقلي بسيار قابل Δ به تكه نسب- ناشي از زلزله Δ براي ΔPلنگر ثانويه ناشي از اثر 

 لذا براي ،شود بررسي مي،از سوي ديگرروي محوري ناشي از بارهاي ثقلي  از يك سو و ني-توجه است
ها ظاهر شده زلزله در آنكه نيروي   استفاده شود بارگذاريهاي از تركيبد بايΔP  بارانتخاب تركيب

 نيرويناشي از ) تغيير مكان جانبي (Δناشي از بار ثقلي و ) نيروي محوري (P يعني بايد اثر ،باشد
  .زلزله منظور شود

  :ي زير را در نظر بگيريد بارگذارهايمثلا ً تركيب
                                                                   L 7/1 + D 4/1  

                                                              ELD 40312751051 /// ±+  
                                                                               E 43/1 ± D 9/0  
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 استفاده L 7/1 + D 4/1 از تركيب  نبايد سه تركيب فوق  بيناز ΔP بار براي تعيين تركيب 
  درنتيجهو ناشي از بارهاي ثقلي Δ وشود نيروي زلزله مشاهده نمي زيرا در اين تركيب اثري از ،دشو

 هايي از تركيبد تا اين قسمت مشخص شد كه باي، تركيب بحراني نيستΔP براي اثر، باراين تركيب
   .ها ظاهر شده استاستفاده شود كه نيروي زلزله در آن

  :دنگيرنظركردن از جمله مربوط به نيروي زلزله مورد بررسي قرار مييي با صرفدو تركيب انتها
  

ELD 40312751051 /// ±+  
E431/± D 9/0  

  
LDشود كه تركيب با ملاحظه دو تركيب فوق مشخص مي 2751051 // تري نسبت  حالت بحراني+

  .شود معرفي ميΔPعنوان تركيب بار مذكور به   بارركيب بنابراين ت، خواهد داشتD 9/0به تركيب 
  :مبحث دهم مقررات ملي ساختمان ايران به شرح زير است و ACIنامه آبا و  مطابق با آيينΔPبار تركيب 

  ΔP  بارتركيب  نامهآيين
L 2/1 + D  نامه آباآيينهاي بتني بر اساس پروژه
ACI   L 275/1 + D05/1نامه  آيينهاي بتني بر اساسپروژه
L + D  تنش مجازهاي فولادي بر اساس پروژه

 هاي مختلفنامه براساس آيينΔPتركيب بار) : 1-7(جدول 
  

 ΔPنوان تركيب بار عبه (D+L)البته برخي از مهندسين محاسب تركيب بار بدون ضريب را 
  :1كنند، برخي از دلايل انتخاب اين نوع تركيب بار به شرح زير استمعرفي مي

 به بعد اشاره 95 از ويرايش ACI318نامه بتن آمريكا  آيين1-11-10 در تفسير بند -1
 ΔPهاي تشديد يافته توسط تحليل شده است كه بارهاي بهره برداري و تغيير شكل

  .محاسبه شوند) بدون ضريب(برداري بايد با استفاده از بارهاي بهره
شود و نيروهاي بدست آمده از تحليل همواره از بارهاي  در تحليل ظاهر ميΔPاثر  -2

هاي بارگذاري شوند و براي استفاده در طراحي، با تركيببدون ضريب محاسبه مي
 .گيرندنامه مورد استفاده قرار مينظر آيينمورد

 و استفاده از اين ΔPدار در تحليل  درصورت استفاده از تركيب بارگذاري ضريب -3
 LRFDدر طراحي بتن و طراحي (دار طراحي هاي بارگذاري ضريبنتايج در تركيب

  .لزامي به اين امر نيستشود كه اها اعمال ميبزرگنمايي مضاعفي بر آن) فولادي

                                                 
 رضا فاروقياي از مهندس عليهاي سازهو برنامه) ΔP(مقاله تحليل مرتبه دوم  -14مجله ساختمان و كامپيوتر شماره  - 1
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با توجه به استفاده از تحليل استاتيكي خطي و استفاده از پريود استاتيكي و عدم برآورد دقيق : تذكر
شود در جهت اطمينان، از تركيب بار معرفي شده در متن بارهاي مرده و خصوصاً زنده، توصيه مي

  .استفاده نماييد) 1-7جدول (كتاب 
  .هاي بتني و فولادي بدست آوريد را براي پروژهΔPاري تركيب بارگذ :1-7 مثال

  :پروژه فولادي 
D + L + LR =بارتركيب  ΔP  

  :پروژه بتني 
LRLD 27512751051 ///  ACIنامه آيين براساس ΔP  بارتركيب= ++

   LRLD 2121 //  نامه آبا آيينبراساس  ΔP ركيب بارت = ++
                      

  تحليل فاز صفر -7-1-3
تحليل فاز . شود از تحليل فاز صفر استفاده مي،سازي از روي دياگرام نيروهامنظور كنترل مدل به

اي و نيروهاست صفر تحليلي است كه هدف از آن، استخراج اطلاعاتي در مورد مدل معرفي شده 
  .دنگيرحاصل از اين تحليل براي مقاصد طراحي مورد استفاده قرار نمي

و تحليل اصلي مدل را كرد نظر را در مدل اعمال  توان تغييرات موردپس از تحليل فاز صفر مي
 . انجام داد

 از هر نوع پيچيدگي و عوامل دي با،سازي از روي دياگرام نيروهابراي استفاده از روش كنترل مدل
 تمامي تيرها از يك تيپ ،ها از يك تيپ تمامي ستوند بايطور مثاله  ب،تعارف در مدل اجتناب شودنام

  .دنثير موضعي نگذاراها تد تا سختي اعضا بر دياگرامنو تمامي بادبندها از يك تيپ انتخاب شو
  .تسازي از روي دياگرام نيروها در فصل هشتم مورد بررسي قرار خواهد گرفكنترل مدل :تذكر

  
  مشخصات مدل مناسب براي تحليل فاز صفر  -7-1-3-1
 2IPE240 طبقه از 6هاي متعارف تا مثلاً براي ساختمان( دنها ازيك تيپ معرفي شوكليه ستون -

 .) بتني40×40يا مقطع 
 يا مقطع 2IPE180متعارف هاي رهاي با دهانهيتمثلاً براي (د نكليه تيرها ازيك تيپ معرفي شو -

 .) بتني40×30
 .)2UNP80 طبقه  از 6هاي متعارف  تا  براي ساختمان مثلاً( دنيك تيپ معرفي شو ليه بادبندها ازك -
اشته باشد، ممكن است اختلالاتي دي با ارتفاع طبقات تيپ شدر صورتي كه ارتفاع برخي طبقات تفاوت فاح -

 .يكسان معرفي نمودتوان در تحليل فاز صفر ارتفاع طبقات را در دياگرام نيروها پديدار شود كه مي
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          (…Display > Show Tables)نتايج خروجي   اطلاعات ورودي ونمايش -7-2-2-6
مـدل  و طراحـي   ناشي از تحليـل  ورودي و نتايج خروجيعات توان اطلابا استفاده از اين دستور مي 

 بــا اجــراي ايــن دســتور پنجــره اطلاعــاتي.  مــشاهده نمــود اطلاعــاتيولااي را بــه صــورت جــدســازه
 ” “Choose Tables for Display12-7شكل  (شود ظاهر مي(.   

  

  
 مشاهده اطلاعات ورودي و نتايج خروجي) 12-7(شكل 
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  :طلاعاتي به شرح زير است اين پنجره اهايدكمه
  . ي موردنظر را انتخاب نمودابارهماهيت توان مي  دكمه اينبا كليك روي :
نتايج بارهاي مورد نظر براي مشاهده       ماهيت و تركيب   ،به كمك اين دكمه    :

  . شوندها، انتخاب ميخروجي، تحت اثر آن
هاي تي گزينهتنظيمات اطلاعات درخواستوان مي  دكمه اينبا كليك روي :

 .مورد نظر را با يك نام مشخص ذخيره نمود
هاي تنظيمات اطلاعات درخواستي گزينهتوان مي  دكمه اينبا كليك روي :

 .مورد نظر را كه توسط دكمه فوق ذخيره شده است مشاهده نمود
Selection Only :  قبـل از   در صورت فعال كردن اين گزينه، اطلاعات ورودي تنها براي اعضايي كـه

   .اند، نمايش داده خواهند شداجراي اين دستور انتخاب شده
 ازهـاي مختلفـي   گزينـه  امكـان انتخـاب   Choose Tables for Display“ ”پنجره اطلاعـاتي  در

دسـته اول كـه     . ها در دو دسته اصلي قرار دارند      ، اين گزينه  وجود دارد  خروجي   اطلاعات ورودي و نتايج   
ــات    ــه اطلاعـ ــوط بـ ــدتا مربـ ــدل  عمـ ــده در مـ ــي شـ ــصات معرفـ ــت ورودي و مشخـ ــازي اسـ   سـ

(MODEL DEFINITION) و دسته دوم كه  مربوط به نتايج خروجي  (ANALYSIS RESULTS) 
هـاي مربـوط بـه هـر گزينـه در        زير گزينه  با كليك روي علامت     . اعم از نتايج تحليل و طراحي است      

 و كليـك روي دكمـه       ) ينهزگ كنار   كليك روي   (ها  دسترس قرار گرفته كه با انتخاب آن      
منظور مـشاهده اطلاعـات     به. صورت جداول اطلاعاتي ارائه خواهند شد     در انتها، اطلاعات درخواستي به    

 . شود از جعبه كشويي بالاي جداول اطلاعاتي استفاده مي،هاي انتخاب شدهمربوط به هريك از گزينه
از ليست  ها  رار نگرفته باشند، گزينه مربوط به آن      سازي مورد استفاده ق   هايي در مدل  چنانچه داده  :تذكر

  .  حذف خواهد شدChoose Tables for Display“ ”قابل دسترس در پنجره اطلاعاتي 
از  خروجي ناشي از تحليل يا طراحي مربوط به   هاي، گزينه در صورت عدم تحليل يا طراحي مدل       :تذكر

  .  حذف خواهند شدChoose Tables for Display“ ”ليست قابل دسترس در پنجره اطلاعاتي 
  .د شدنتشريح خواه دارند،كه مورد استفاده بيشتري  هاي كاربرديگزينه برخي ادامهدر 

 Point Coordinates   :ها را درخواست نمـود توان مختصات هر يك از گره به كمك اين گزينه مي .
 معرفـي و مختـصات      ETABSافزار  نرمپس از اجراي اين دستور هر نقطه با نام نسبت داده شده توسط              

اين دستور براي يافتن يك نقطه با شـماره مـشخص كـه ممكـن اسـت در                  . شودآن در جدول درج مي    
  .  مناسب خواهد بودشود،ه ئافزار اراهاي خطا و هشدار توسط نرمپيغام

Line Connectivity    :ارافـز توان نام نسبت داده شده توسط نـرم به كمك اين گزينه مي  ETABS  بـه
 مـشاهده    را نظـر   خطي تير، ستون و بادبند به اضافه شماره گره ابتدا و انتهاي عضو مورد              اعضايهريك از   

 كـه  ETABS افـزار  خطي با نـام اختـصاص داده شـده توسـط نـرم      عضواين دستور براي يافتن يك      . نمود
   .)13-7شكل ( خواهد بود  مناسبشود،ه ئارا افزارهشدار توسط نرم هاي خطا وممكن است در پيغام
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  هاي گام به گام مثال:گام سوم
  

  .هاي فولادي و بتني تشريح خواهد شدسازي و تحليل فاز صفر براي پروژهدر اين قسمت تنظيمات مدل
  
    پروژه فولادي-7-3-1
   هندسي سازيمدلكنترل  -7-3-1-1

 براي ايـن منظـور دسـتور    .رل شود كنتسازه  سازي هندسي    ابتدا بايد مدل   ،تحليلقبل از تنظيمات    
Analyze > Check Model…ـپنجره اطلاعاتي ظاهر شده كليه گزينه   را اجرا كرده و در  جـز  ه ها، ب

مقـدار پـيش   ( .كنيـد كليـك   فعال و روي دكمـه  را   Selected Objects Onlyگزينه 
  )  مناسب است  Tolerance for checksفرض

تـوان  سـازي هندسـي بـدون اشـكال بـوده و مـي            ه نشود مـدل   در صورتي كه پيغام خطايي مشاهد     
  . تنظيمات مربوط به تحليل مدل را انجام داد

  
  ΔPتنظيمات تحليل و درخواست تحليل  -7-3-1-2

 به ترتيب زير عمـل     ΔPبراي تنظيمات مربوط به تحليل پروژه فولادي و همچنين معرفي تحليل            
  :دكني

  .دكني اجرا  را …Analyze > Set Analysis Optionsدستور  -
  .نظيم درجات آزادي سازه انتخاب كنيدبراي ترا  Full 3Dدر پنجره اطلاعاتي ظاهر شده گزينه  -
 .را غيرفعال نماييدDynamic Analysis گزينه  -
 .كنيدكليك  فعال و روي دكمه را   Include P- Deltaگزينه  -
را انتخـاب   Iterative – Based on Load Combination  ๏طلاعاتي ظـاهر شـده روش  در پنجره ا -

 . دكني
 همگرايي حالت پيش فرض مناسب اسـت        .كنيد معرفي   5برابر  را   ΔP تعداد تكرار تحليل     حداكثر -

 .شودو بدون تغيير پذيرفته مي
زنـده   با توجه به آنكه دو ماهيت بار      .  بررسي شد  1-7 در مثال    ،ولاديبراي پروژه ف   ΔPبار  تركيب  

 معرفي  ΔP بار    به عنوان تركيب    RL + LIVE + DEADبار   بايد تركيب    ،در پروژه معرفي شده است    
  .شود

انتخـاب  را ) DEAD(ت مرده  بار با ماهيLoad Case از جعبه كشويي ΔPبار براي معرفي تركيب  -
  .كنيدكليك رفي و روي دكمه مع1برابررا   Scale Factorو مقدار 

انتخـاب و  را ) LIVE REDUCE( بار با ماهيـت زنـده قابـل كـاهش     Load Case از جعبه كشويي -
  .كنيدكليك   معرفي و روي دكمه 1برابر   را  Scale Factorمقدار 
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 Scaleانتخاب و مقدار را ) LIVE(با ماهيت زنده غير قابل كاهش  بار Load Case از جعبه كشويي -

Factor    كنيدكليك   معرفي و روي دكمه 1برابر را.  
   .انجام خواهد شد ΔP تحليل تنظيمات تحليل و معرفي با كليك روي دكمه 

 
  تحليل مدل  -7-3-1-3

بـا اجـراي دسـتور      .  انجام عمليات تحليل خواهـد بـود       هاي تحليل، مدل آماده   پس از تنظيم گزينه   
Analyze > Run Analysis  ) يا فشردن دكمهF5 ( ايـن دسـتور از طريـق    .مدل تحليل خواهد شد 

 د نباي ، در حين عمليات تحليل    .از نوار ابزار بالاي صفحه نيز قابل دسترسي است          كليك روي دكمه  
تـوان   مي …File > Last Analysis Run Log دستوربه كمك. پيغام خطا و يا هشدار مشاهده شود

گيرد با اجراي اين دستور فايلي در دسترس قرار مي. مراحل طي شده حين عمليات تحليل را مرور كرد   
  .شودهاي حين تحليل در آن درج ميهمراه پيغامه كه اطلاعاتي در مورد مدل و تحليل سازه ب

سـازي   نسبت بـه اصـلاح مـدل       بايد) Warning( يا هشدار    ) Error( خطا  صورت وجود پيغام     در
سـازي  چنانچـه مـدل  . سازي در فصل هشتم به تفصيل تشريح خواهد شد         نحوه كنترل مدل   .اقدام نمود 

  .  مدل بدون پيغام خطا و هشدار تحليل خواهد شد،ه شده انجام گرفته باشدئمطابق توضيحات ارا
  
   پروژه بتني -7-3-2

 تحليـل    و ΔPهاي تحليـل و درخواسـت تحليـل         سازي هندسي، تنظيم گزينه   لمراحل كنترل مد  
 معرفي شده در   ΔPبار   جاي تركيب ه   تنها ب  ، مشابه توضيحات پروژه فولادي است     مدل در پروژه بتني   
مطـابق  . تني استفاده و اين تركيب در مدل معرفي شـود           پروژه ب   ΔP بار    تركيب  از پروژه فولادي بايد  

  تركيـب  ،زنده قابل كاهش و بار زنده غيرقابل كـاهش          و معرفي دو نوع بار زنده با ماهيت بار         1-7مثال  
  . خواهد بودزير در پروژه بتني مطابق تركيب ΔPبار 

LRLD 27512751051 /// ++ 
 حاصـل از    ΔP بـار     تركيـب  ، انجـام خواهـد شـد      ACIنامـه   يني براساس آ   به علت آنكه طراحي    :تذكر

  .شود در مدل معرفي ميACIتركيبات بارگذاري 
  بايد در محاسبات منظـور شـود و در پـروژه             ΔP  اثر ه بتني به علت وجود قاب خمشي،      در پروژ : تذكر

 بـه احتمـال زيـاد مطـابق ضـوابط      ، خمشي آن هم در امتداد كوتاه سـازه فولادي با توجه به وجود قاب     
شاخص پايداري طبقه كمتـر از      احتمال آنكه   (   در محاسبات منظور شود     ΔP بايد اثر  2800استاندارد  

 در محاسـبات    ΔPتوان در پروژه فولادي لـزوم اثـر       در صورت تمايل مي    .) درصد باشد، ناچيز است    10
  .تحليل سازه را بررسي نمود
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   در اسكلت بتني اعضااثر ترك خوردگي -7-3-2-1
  :اي اسكلت بتني به ترتيب زير عمل كنيدخوردگي اعضاي سازهبراي منظور كردن اثر ترك

اجرا و در پنجـره اطلاعـاتي ظـاهر شـده توسـط      را   … Select > by Line Object Typeدستور -
  .دكني انتخاب  راها كليه ستونColumnگزينه 

اجـرا و در پنجـره   را  …Assign > Frame / Line > Frame Property Modifiersدسـتور   -
و  (Moment of Inertia about 2 (& 3) axis)هاي خمشي اطلاعاتي ظاهر شده ضرايب سختي

 .كنيد معرفي 7/0برابر را (Torsional Constant)پيچشي 
اجرا و در پنجـره اطلاعـاتي ظـاهر شـده توسـط      را   … Select > by Line Object Typeدستور -

  . را انتخاب كنيد كليه تيرهاBeamگزينه 
اجـرا و در پنجـره   را  …Assign > Frame / Line > Frame Property Modifiersدسـتور   -

و  (Moment of Inertia about 2 (& 3) axis)هاي خمشي اطلاعاتي ظاهر شده ضرايب سختي
 . معرفي كنيد35/0را برابر  (Torsional Constant)يچشي پ
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   آموزشي عمرانكده-موسسه علمي 
 آموزشي عمرانكده با هدف ارتقاي سطح دانش كاربردي -موسسه علمي  

مهندسي عمران و امكان برقراري ارتباط و تبادل تجربيات ميان مهندسين 
  :شودميش عمده تقسيم فعاليت اين موسسه به دو بخ. عمران شكل گرفته است

  
   و سمينارهاي تخصصيهاي آموزشي دوره-1

 برگزاري ، اقدام به انتقال تجربيات و دانش مهندسي عمران به ساير همكاران با هدفدراين بخش  
ها با توجه به اصل سادگي در بيان و محتوي دوره. شودكاربردي و آموزشي ميمختلف هاي دوره

منظور پاسخگويي به نياز آموزش  همچنين به. تنظيم شده است،هاي عمليكاربردي بودن آن در پروژه
 تخصصي اقدام به برگزاري سمينارهاي ،تخصصي مطالب خاص، خصوصاً در زمينه محاسبات ساختمان

 در ي آموزشي و سمينارهاي تخصصيهانام در هر يك از دوره رزرو و ثبت، تقويم برگزاري.استشده
  . قابل دسترسي استwww.OmranKadeh.netسايت 

  :توان به موارد زير اشاره نموده شده ميائ ار آموزشي و سمينارهاي تخصصيهاياز جمله دوره
 

  هاي آموزشيدوره
ها و آشنايي با سوله و معرفي ديتيل (آموزش محاسبه و طراحي سوله دوره مقدماتي

طابق با مبحث ششم، هاي سوله، بارگذاري ثقلي و جانبي سوله مهاي مختلف سازهالمان
سازي جهت طراحي دقيق  و نحوه اصلاح نتايج مدلSAP2000افزار ها در نرمسازي قابمدل

  )اي، طراحي شالودههاي مختلف سازهبا اين نرم افزار، نحوه طراحي دقيق المان
، MEZZANINEمعرفي و نحوه طراحي  ( دوره تكميليآموزش محاسبه و طراحي سوله

 & IBC2003هاي ها و نحوه آناليز و طراحي آنها، بررسي آيين نامهاثقالمعرفي انواع جر
UBC97 جهت بارگذاري ثقلي و جانبي در حالات خاص، بررسي اثر P-Delta در طراحي 

  اي، بررسي اثر ديوارهاي محيطي در طراحي سازههاقاب
ارگذاري آشنايي و معرفي سيلوهاي بتني، ب(آموزش محاسبه و طراحي سيلوهاي بتني 

  )، طراحي سازه و شالوده سيلوSAP2000سازي و آناليز سيلو به كمك نرم افزار سيلو، مدل
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  هاي آموزشيدوره

سازي و آناليز اسكلت، مدل (آموزش كاربردي محاسبات ساختمان دوره مقدماتي
 .)هاي اين دوره منطبق بر جلد اول كتاب آموزش كاربردي محاسبات ساختمان استسرفصل

طراحي اسكلت هاي بتني و  (آموزش كاربردي محاسبات ساختمان دوره تكميلي
هاي اجرايي و دفترچه محاسبات، طراحي اتصالات و فولادي، محاسبات شالوده، تهيه نقشه

 )شود را شامل مي13 و 12،قسمتي از4،3،2،1ها، اين دوره سمينارهاي رديف صفحه ستون
 
 

  موضوع سمينار رديف
 ETABS2000افزار ها به كمك نرميل ديناميكي ساختمانآموزش تحل 1
 ETABS2000سازي و تحليل و طراحي ديوارهاي برشي در نرم افزار آموزش مدل 2
  

هاي خمشي معمولي، متوسط و ويژه بتني در نرم افزار آموزش طراحي و لرزه نگاري قاب 3
ETABS2000  

  

مولي، متوسط و ويژه فولادي در نرم افزار هاي خمشي معآموزش طراحي و لرزه نگاري قاب 4
ETABS2000  

 ETABS2000 در نرم افزار EBFآموزش طراحي و لرزه نگاري بادبندهاي   5
 ETABS2000 در نرم افزار CBFآموزش طراحي و لرزه نگاري بادبندهاي   6
 ETABS2000هاي فولادي به كمك نرم افزار آموزش طراحي اسكلت 7
 ETABS2000هاي بتني به كمك نرم افزار آموزش طراحي اسكلت 8
  هاي بتني و فولاديآموزش تهيه دفترچه محاسبات ساختمان  9
  

هاي ساختماني به كمك نرم افزار سازي، تحليل و طراحي انواع شالودهآموزش مدل  10
SAFE2000 

  

سن آنها به همراه طراحي هاي سقف و بررسي معايب و محاآشنايي با انواع مختلف سيستم  11
  ها انواع سقف

  ها و ميل مهارهاآموزش طراحي صفحه ستون  12
  )ساده، صلب، اتصالات بادبندها(آموزش طراحي انواع اتصالات  13
  آموزش طراحي تير ورقها 14

 
 در ، آموزشي عمرانكده از تمامي اساتيد، مهندسين و دانشجويان مهندسي عمران-موسسه علمي  

  .نمايدهايي استقبال ميهاي علمي و آموزشي دعوت به همكاري نموده و از چنين همكاريفعاليتزمينه 
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    تاليفات آموزشي-2
تاليفات كاربردي و آموزشي مهندسي عمران  آموزشي عمرانكده، -هاي موسسه علميديگر فعاليتاز 

توان به موارد كه از آن جمله ميافزارهاي كاربردي است ها و نرماين تاليفات شامل انواع كتاب. است
  :زير اشاره نمود

  ) تحليل اسكلت ساختمان وسازيمدل( جلد اول -  كتاب آموزش كاربردي محاسبات ساختمان-1
سازي، تحليل و مدلو طراحي ساختمان ( جلد دوم -  كتاب آموزش كاربردي محاسبات ساختمان-2

  )طراحي شالوده ساختمان
 ها،صفحه ستون، ها، اتصالاتسقف(و جزييات ساختمان  شالوده ،اسكلتدر جلد دوم كتاب طراحي   
اي با توجه به كاربردي بودن كتاب، بيان مطالب به گونه. د گرفتنمورد بررسي قرار خواه...) ها و پله

هاي كاربردي نظر و از محاسبات و طراحي الامكان از محاسبات پيچيده و تئوريك صرفكه حتي است
 ،افزارهاي كمكي همچنين با طراحي نرم، بهره گرفته شود،هاي متعارفده در ساختمانمورد استفا
  .افزارها انجام شود محاسبات دستي به كمك اين نرم،سعي شده

  . معرفي شده است5در پيوست هاي جلد دوم كتاب فصلاز سربرخي 
  )اختمانمحاسبات پيشرفته س(جلد سوم  -آموزش كاربردي محاسبات ساختمان  كتاب -3

برخي از . در اين كتاب مباحث پيشرفته تحليل و طراحي ساختمان مورد بررسي قرار خواهد گرفت
تحليل ديناميكي ساختمان، بارگذاري باد، تحليل و طراحي :عبارتند ازين كتاب  امطالب عنوان شده در

  ...پذيري ويژه و ديوارهاي برشي، كنترل ضوابط شكل
  حاسباتي و تخصصي محاسبات ساختماناي مهافزارهطراحي نرم -4

افزارهاي تخصصي  طراحي و توليد نرم، آموزشي عمرانكده-هاي فعاليت موسسه علمييكي از بخش
  سايت از طريق، تست نهاييپس از تكميل وافزارها در دست طراحي است و اين نرم. است

www.OmranKadeh.netد بودنها قابل دسترسي خو.  
  

 عمرانكده از تمامي اساتيد، مهندسين و دانشجويان مهندسي عمران در زمينه  آموزشي-موسسه علمي
، افزارهاي تخصصينرمهاي تخصصي و كاربردي و همچنين در زمينه طراحي و توليد تاليف كتاب

  .نمايددعوت به همكاري مي
  

      Info@OmranKadeh.net: آدرس پست الكترونيكي 
          www.OmranKadeh.net: آدرس سايت اينترنتي 

  66488305: تلفن 
  



  

  نظرات و پيشنهادات مهندسين محاسب – 6پيوست 
  

  
از زمان انتشار چاپ اول كتاب همكاران ارجمندي نظرات و پيشنهادهاي اصلاحي و فني خود را به 
اينجانب منتقل نمودند، خصوصاً جناب آقاي مهندس صمد آقا زاده و جناب آقاي مهندس علي 

ز اين مطالب براي استفاده ساير خوانندگان در اين سليماني نيا كه ضمن تشكر از اين عزيزان بخشي ا
  .پيوست آمده است

  
  اندهاي بتني كه در يك امتداد مهاربندي شدهاثر ديوار برشي در سازه -1

شود كه ديوارهاي درصورتي كه سازه سه بعدي با ديد ديناميكي مورد بررسي قرار بگيرد مشاهده مي
هاي ديناميكي به مراتب بهتري حتي براي امتداد دارند بازتاببرشي كه تنها در يك امتداد سازه قرار 

   .است عنوان شده66اين مورد در اصلاح مطلب صفحه . خمشي خواهند داشت
  
  اتصال صلب و مفصلي پاي ستون -2

ها به عنوان عامل ها در پاي ستوناست كه در كتاب تنها وجود نبشي يا سخت كنندهشدهتذكر داده
در )  كتاب69 و 68صفحه (است ها معرفي شده عملكرد صلب يا مفصلي پاي ستونتعيين كننده در

  .نيز در رفتار اتصال پاي ستون موثر است) هابلت(صورتي كه آرايش و مقاومت ميله مهارها 
تذكر فوق صحيح است و اگر در كتاب به اين مورد اشاره نشده به دليل آن است كه استفاده از آرايش 

ها مطرح هاي صنعتي و سوله معمولاً در سازه،ه مهارها براي تعيين نوع اتصال پاي ستونو مقاومت ميل
كه معمولاً در (ها و ميله مهارها ها با توجه به شكل متداول اجراي صفحه ستوناست و در ساختمان

 )يشود نه فقط در امتداد يك محور مركزهاي صفحه ستون از ميله مهار استفاده ميها و لبهگوشه
  .معمولاً بحث دوران مجموعه ستون و صفحه ستون نسبت به شالوده قابل توجه و تعيين كننده نيست

  
   حذف محورهاي مزاحم-3

 كتاب توضيح داده شده، 93رد حذف محورهاي مزاحم در صفحه آنچه در موتري نسبت بهروش ساده
 (Secondary) حورهاي فرعيعنوان مپيشنهاد شده است به اين ترتيب كه اگر محورهاي مزاحم به

ها را  آنSecondary Grids و غيرفعال كردن گزينه توان به كمك دستور معرفي شوند مي
   .حذف و ترسيم بادبند را انجام داد
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   محاسبه خودكار نيروي زلزله در صورت وجود نيروي شلاقي-4
قي وجود داشته باشد بايد  و نيروي شلا< s 7/0 T در فصل ششم توضيح داده شد كه در صورتي كه 

روش پيشنهادي . افزار معرفي شود به نرمUser Loadsنيروي زلزله بصورت دستي محاسبه و با روش 
نوشته  UBSنامه هاي فولادي بر مبناي آييناي ساختمانبرگرفته از كتاب رفتار و ضوابط طراحي لرزه

  :آقايان نيكنام، ثنايي، هاشمي و باجي، به شرح زير است
نامه  در آيينC و 2800 در استاندار B( در ضريب بازتاب 2800 و استاندارد UBC94نامه تفاوت آيين

UBC94 (پارامتر توان است كه با مساوي قرار دادن دو ضريب ميSنامه  آيينUBC94  را با توجه به
 و پريود sT=/50 و  S=/50 مقادير 2800مثلاً چنانچه در استاندارد.  معادل نمود2800استاندارد 

  : باشد خواهيم داشتTsساختمان بزرگتر از 
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 معرفي شود به S=26/1درصورتي كه  UBC94 نامهيعني در چنين حالتي درصورت استفاده از آيين

  . خواهيم رسيد2800زيع مورد نظر استاندارد تو
ضريب بازتاب را به  UBC94نامه البته در استفاده از اين روش به اين نكته توجه داشته باشيد كه آيين

  . چنين نيست2800كند كه در استاندارد  محدود مي75/2عدد 
  
   اتصال تير به تير در اسكلت بتني-5

نظر . شودهاي محاسباتي مشاهد مي بتني در برخي از پروژهاستفاده از اتصال مفصلي در تيرهاي
مهندسين محاسب بر اين اساس استوار است كه با منظور كردن جزييات اجرايي خاص مانند عدم 

 هاينمونه چنين حالتي در تيرچه. توان به رفتار مفصلي نزديك شدتير فرعي مياستفاده از قلاب در انتهاي 
ها استفاده ها از فرض دو سر مفصل بودن تيرچهود دارد كه براي طراحي آنبتني سقف تيرچه بلوك وج

شود كنترل شود كه آرماتورهاي درصورت استفاده از اتصال مفصلي براي تيرهاي بتني توصيه مي. شودمي
  .دن تامين شده باش،اكثر آرماتور خمشي تيرد درصد ح15 حداقل معادل ،قسمت فوقاني تير

  
  ي طبقاتا ارتفاع سازه-6

تحتاني تا روي تير ها را از روي  ارتفاع ستونETEABS2000افزار است به علت آنكه نرمپيشنهاد شده
هاي معماري اي طبقات از رقوم مندرج در نقشهگيرد، براي معرفي ارتفاع سازهتير فوقاني درنظر مي

  .استفاده شود
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